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Abstract
We discuss the issues involved in building an improved input/ output
system for equational logic programs. In particular, we present requirements for a protocol especially suited to the lazy communication
of term structures. We also present requirements for a term browser, a
front-end for equational logic programs. In addition, we describe our
implementation of the browser.
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Introduction

After extensive work with the equational logic programming system [4], we
determined that users of equational logic programs ( and, hence, equational
logic programmers) are hindered by its input/output system. In particular,
although compiled equational logic programs operate lazily ( and , hence ,
inspect their input lazily) , the current front end reads all the input before
the program starts to run, even when only a portion of the input is required
in order to produce output.
In addition, users can only control the output by constructing elaborate
requests. For example, if primes[] is the infinite list
2,3,5, 7, ...
and a user wants to see the first ten primes, (s )he can't just ask for primes[]
and have the system pause after ten primes; instead, (s)he must develop a
request like:
firstn[10; primes[]]
If, at a later time, the user decides to examine the eleventh prime, ( s )he
must rerun the program with a new input and specification, such as:

firstn[11; primes[]]
Once a request has been completed, the program terminates. Hence, if the
user is to obtain further information, everything must be recomputed. The
system would give users much more freedom if it allowed users to make more
general informational requests and supported browsing requests of the form
"give me more information about this portion of the output term."
Finally, this all or nothing system prevents interaction. Because users
must specify the full input in advance, they are unable to develop the input
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term gradually, possibly using information garnered from the output (as , for
example, one would do when playing a game).
To alleviate these problems, we decided to:
• develop a lazy 1/0 protocol especially suited to term communication;
• integrate this protocol into equational logic programs; and
• develop a front end that gives users a comfortable and convenient
interactive interface to equational logic programs.

In developing the Browser, we were able to implement a system in which the
front end could run on a system geared for interaction while the computation
could run on a separate machine (or machines) .
This report describes our initial work on the experimental Browser.

2

Motivations

Our primary goal in writing the rewrite browsing system was to provide
a convenient and comfortable system that would encourage people to use
equational logic programs. Most of the system falls into one of two distinct primary categories: the direct user interface (i.e .. the way the system
displays information to the user, the actual sequence of actions that a user
would use when working with the system, and so on), and the low-level communication protocol ( the commands equational logic programs would use to
communicate with both the user interface and also with other equational
logic programs).

2.1

A Lazy Interface

Both input to and output from equational logic programs are terms that are
represented as trees. The standard version of the equational logic programming system requires one to represent terms textually rather than visually.
Although that system includes a simple pretty-printer for terms , users are
effectively forced to view tree structures (terms) one-dimensionally ( as linear
text). Now that high-resolution bit-mapped displays are widely available,
we felt that the system should instead:
• display twerdimensional representations of terms;
• allow the user to move through the representations with arrow keys
and/or by pointing and clicking on nodes; and
4
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Figure 1: The tree corresponding to the term reverse[(a b c)]
• allow the user to construct/define terms gradually, by selecting nodes
with unspecified contents and chosing a symbol to label the node or
pasting a subterm from another part of the term.
The third capability allows users to construct subterms selectively without
concerning themselves with other subterms.
Clearly, there are many reasonable two dimensional representations of
terms. In fact, pretty-printed terms serve as reasonably good representations, if one provides facilities for selecting nodes. After considering many
alternate representations , we decided to emphasize the tree nature of terms
and represent them as rooted trees with the root placed near the top of the
screen. For example, we represent the term
reverse[(a b c)]
with the tree in Figure 1.
The Browser must provide both an input window (in which the user
constructs the input term) and an output window (in which the user browses
the corresponding output). The Browser must allow users to explore terms
similarly in both the output and input windows. When a user requests
information that the Browser has not yet obtained, the Browser should query
the corresponding equational logic program to obtain information about the
output term and present that information to the user.
Since we want to allow users to develop input as they browse output,
we do not require that users specify the complete input term before they
begin to browse the output. ff the user has not defined the portions of the
term that the program requires, the Browser should highlight the needed
5
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The Dance Protocol

Based upon our thoughts regarding the relationship between terms and pipes
(as described in Section 2.2), we developed a communication protocol designed to facilitate the lazy communication of terms. Because we wanted
to make it clear that the consumer, rather than the producer, guides the
transmission of information, and because the two act in concert, we chose
a metaphor of dancing, with the consumer acting as the leader and the
producer following the consumer's lead and responding to the consumer's
requests. We refer to the consumer in a dance as Fred and the producer as
Ginger.
A dance between Fred and Ginger consists of a series of traversal and
information requests from Fred, and corresponding responses from Ginger.
We require that Ginger respond to every request from Fred, but allow her to
say something corresponding to "No!" We include this restriction to allow
Ginger to cope with the times that Fred makes inappropriate requests. For
example, we want to allow Ginger to deal with requests like "go forward to
the third child of a binary node." Finally, we require that Fred wait for a
response from Ginger before sending his next request.

3.1

Revision

Revision is a stick subject: there are situations in which the ability to revise
terms is very useful (for example, in an editor); there are also situations in
which revision is inappropriate (for example, in equational logic programs).
The protocol does not prevent revision nor does it encourage revision; instead, it provides for both by including a command that Fred must send to
indicate that a node can no longer change.

3.2

Legal Requests

Fred's possible requests are:
STABILIZE The command that Fred uses to indicate that he needs Ginger
to chose a final form for the present node in the term. Ginger never
responds to a STABILIZE command with "No"; she either responds
with "Yes" or never responds.
UP <amount> A request to move towards the root of the term. UP takes

one argument-the number of levels to move up in the term. Ginger
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responds to an UP request with "Yes" if the present location of the
dance is at least <amount> levels below the root in the term and "No"
otherwise.
<child> A request to move down in the term, towards a child.
takes one argument, the number of the child. Ginger responds
with "No" if the node has fewer than <child> children or if Fred has
not yet sent a STABILIZE request referring to that node.

DOWN

DOWN

A request to move directly to the root of the term. Ginger always
responds to this request with "Yes."

HOME

The single information request. Ginger responds to a STABILIZE
request with the type of symbol in the node (function, integer, truth,
atomic), the value of that symbol (the name of a function or atomic
symbol, the value of the integer), and, if it was a function symbol,
with the arity of the symbol.

LOOK

3.3

Joining Programs

Clearly, a system in which only one program takes the role of Fred and
only one program takes the role of Ginger is quite boring. In fact, the
Dance protocol allows programs to participate as both Freds and Gingers
in multiple simultaneous Dances. This facility is similar to the multiple
input and/or output channels for processes in [3].
Since the primary emphasis of our research is on building better front
ends for equational logic programs, we do not make extensive use of this
multiple dance facility. Our compound-dances are fairly simple and usually
consist of:
• An Output Browser. This Fred-program allows a user to browse
the output of another program by converting the user's actions (mouse
clicks, arrow key movements, and so on) to appropriate dance requests.
• One or more equational logic programs. Theses programs serve as
lazy term transducers. Each equational logic program serves as both
a Ginger for some Fred and a Fred for a Ginger.
• An Input Builder. This Ginger-program allows a user to build the
input term and converts dance requests into appropriate prompts to
the user.
9
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Figure 2: A typical compound dance system.
The typical layout of this group is illustrated in Figure 2. In our system, the
Output Browser and the Input Builder are combined into a single Graphic
Shell.

4

The Implementation

Given our requirements for the front end to the system and our definition
of the Dance protocol, we developed the Rewrite Browser. The Browser
has two parts: the Graphic Shell, a front end that allows users to gradually
develop the input and to explore the output term, and the Reduction Engine,
an interpreter for equational logic programs that follows the Dance protocol.
Figure 3 illustrates the relationship between these two parts and the Dance
connections that bind them together.

4.1

The Graphic Shell

The Graphic Shell is a Macintosh2 application that runs under A/UX. It
communicates with the Reduction Engine via an implementation of the
2

Macintosh was once a trademark of McIntosh Laboratories, Inc. Macintosh is now a
registered trademark of Apple Computer, Inc.
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Figure 3: The components of the Browser
Dance protocol layered over TCP /IP. The Shell provides facilities for term
creation, manipulation, display, and browsing. This section gives a quick
overview of the system and some of the questions we encountered during development. A more comprehensive user's guide for the Shell may be found
in Appendix A.
4.1.1

Editing Terms

The Graphic Shell's greatest strengths are the features it provides for creating and editing terms. The Shell can read and write terms using O'Donnell's
format for abstract symbolic information (described in [4]) and display them
as trees. Users are able to edit multiple terms simultaneously, one term per
window. As specified above, users can select nodes using both the mouse
and arrow keys.
The Shell allows users to cut, copy, and paste arbitrary subterms. These
facilities are especially useful when a user wants to reuse information from a
separate term (including an output term). They are also helpful when a user
wants to create a term with many identical subterms (Section 5.2 describes
a better way to handle redundant terms).
We allow users to reorient their view of the term by choosing a node
and making it the top node on the screen. One can choose to Home a
selected node, the parent of that node (useful for stepping up in a tree) , or
the real root of a tree. Figure 4 illustrates the result of homing the parent
of a selected node.
The Shell also allows users to hide subterms with a Close command
11
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Figure 4: An example of the Home Parent command.
and reopen the same subterms with Open. Users can also open or close a
node by double-clicking on the node. Closed nodes are displayed as boxed
upside-down question marks.
If a user attempts to visit a node not currently displayed ( the parent of
the node at the top of the screen, or the child of a closed node or a node at
the bottom of the screen), the Shell determines an appropriate reorientation
of the term and redisplays the term in the new orientation.
4.1.2

Term Layout

Although our decision to represent terms as trees restricts the ways in which
terms are displayed, it does not precisely define the representation of terms,
in that there are many different ways in which a tree can be laid out. Since
the Shell continually updates and redisplays terms, we feel that simple and
quick layout strategies are preferable.
Our first strategy was based on one of the simplest algorithms for displaying trees ( see Figure 5). This strategy partions the screen width available to a term into equal widths for each subterm. This strategy has the
advantages that it is quick, is easy to implement, and avoids extensive recalculation/redrawing when a portion of a term is defined or changed. Unfortunately, if a given tree is not well balanced, the strategy results in a
layout that is unappealing and makes poor use of the screen. For example
this strategy represents a standard list with a picture like that in Figure 6,
which is an unsatisfactory representation.
Our second layout strategy is designed to make more efficient use of the
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proc DrawTerm(term, area)
DrawSymbol(RootSymbol( term), TopCenter( area))
child Width = area.width / Ari ty( term)
childHeight = area.height - deltaHeight
for child = 1 to Ari ty( term)
childArea.width = childWidth
childArea.height = childHeight
childArea.left = (child - 1) * child Width
childArea. bottom = area. bottom
Draw Line(TopCenter( area) , TopCenter( childArea))
DrawTerm(SubTerm(term, child), childArea)
end for
end proc
Figure 5: A simple algorithm for displaying terms.
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Figure 6: A standard list as displayed with the first layout strategy
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Figure 7: A standard list displayed with the second layout strategy.
screen. The basic strategy is to draw all the nodes at a certain level evenly
spaced across the screen. This uses more screen space than the previous
algorithm, and usually produces appealing layouts. It works especially well
with lists, as Figure 7 illustrates.
Unfortunately, this second strategy also has some problems: it 's harder
to implement than the previous strategy, it may require extensive redrawing
when small additions or changes are made in the tree, and it can create some
very ugly and/ or confusing trees, such as the one in Figure 8.
Of course, it's not clear that there is any good way to lay out a tree like
the one in Figure 8. It should be clear that different applications will be
better served by different layout strategies. Presumably, the best solution
would be to attach a graphic method to each window, to each term, or,
perhaps, to each subterm.
Even with its problems, we found that the second strategy worked well
for most equational logic programs. Relatively uniform structures ( such as
lists) form the most typical terms, and the strategy does quite well with such
structures. It is also quite fast, as we are able to recalculate the display and
redisplay the term nearly instantaneously.

14

cons

~
cons

a

------------7
r-------_
------------7d

cons

b

c

cons

cons

Figure 8: A term that the second strategy fails to display well.
4.1.3

Browsing Remote Terms

The Graphic Shell allows users to browse through the output of Reduction
Engines. Users browse these remote terms with commands similar to th06e
they use when browsing locally-created terms. Unknown nodes in the output term are represented as cl06ed nodes. When a user opens a node in a
remote term ( either by double-clicking the node, selecting Open from the
Display menu, or using the down-arrow), and the contents of the node are
unknown, then the Shell sends a series of commands to the engine and displays the contents of the node once the Engine has responded. The series of
commands consists of: movement commands to reach the appropriate location, a STABILIZE command to lock the node, and, finally, a LOOK command
to obtain the node's symbol.
The Shell requires that users do a few things before they begin to browse
remote documents:
(1) Since a user may simultaneously edit many terms, the Shell requires
the user to specify which term should serve as input to the Engine.
(2) Since a user may wish to use one of many Engines running on different
machines, the Shell allows the user to select the appropriate Engine
and/ or machine. If the user does not do so, reasonable defaults are
used.
15

(3) Finally, a user must indicate the desire to start browsing the remote
term. The Shell then opens up a new window and allows the user to
begin browsing.

4.2

The Reduction Engine

We will eventually link the Graphic Shell with the fast compiled equational
logic programs that the current compiler produces. During the development phase of this project, we felt that it would be easier to work with a
straightforward system that did not incorporate the many optimizations the
current compiler performs. The Reduction Engine is a system we built for
this experiment. The Reduction Engine interprets equational logic programs
compiled into pattern matching automata. Our current version runs on Sun
4s. The code is written in C, so it should run on most other machines .
Because many people will be more interested in using the Shell than in
building programs, we have provided a few basic engines including:
• an engine that performs the identity transformation;
• a basic list manipulation package (including reverse, compose, and
flatten); and
• an engine that produces an infinite list of primes (based on the algorithm presented in [3] and given by the equations presented in [4]).

4.3

Implementing the Dance Protocol

We implemented the Dance protocol through TCP /TP, using one socket for
each Dance. Sockets are passed as parameters to individual dancers ( on the
command line in the case of Unix programs). Because the Graphic Shell
manages everything, it creates the necessary connections and connects to
the engines. Precise details of the implementation are omitted.

5

Discussion and Conclusions

Our combined Shell/Engine system gives us a convenient interface to equational logic programs, and the Dance protocol provides a suitable platform
on which to implement such a system. In this chapter we report some of
the major problems we encountered with the Dance protocol, some possible
modifications to the protocol, and some possible extensions of the Shell. We
16

Program:

ones a (1 . ones);
last[(X
nil)] a X;
last[(X. (Y . Z))] = last[(Y. Z)];

Input:
last[ones]
Figure 9: A program and input that will never become head-stable under
that program.
hope to indicate some important considerations for developing communication protocols and/ or building display systems.

5.1

Dance Problems

Because many of our decisions regarding the definition and implementation
of the Dance protocol were rather ad hoc, we found that some problems
appeared during use of the protocol. Fixing many of these problems would
require complete restructuring of the system, so we have simply left them
in for the time being. Term Tours, a revised protocol that eliminates these
problems, will be covered in a future report.
5.1.1

Responding to

STABILIZE

Although Ginger is expected to respond to STABILIZE with "Yes," there are
times when equational logic programs may take forever to head-stabilize a
term. In these situations, Ginger may never respond. For example, Figure 9
illustrates a case in which Ginger will take forever to calculate a stable root
and hence to return any output to the user. Because Fred must wait for a
response before he can do anything else, Fred (and, hence, the user) must
wait forever before they can continue. Although this is the correct thing to
do, it can be quite disconcerting. We developed many possible solutions to
this problem before we arrived at one we felt was appropriate.
One possible change would be to allow Ginger to respond with "No"
after a certain amount of time has elapsed. Another would be to allow
Fred to send a CANCEL command if he decides not to wait for the response.
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Although these facilities might be useful, they raise questions about the state
of the system after a refusal or CANCEL that are beyond the scope of this
paper. For example, an equational logic program in which a stabilization
halts could: revert to the original state; go to a state in which the node is
not stable, but that maintains the stabilization information; or go to a state
in which the node is marked stable.
Another simple possibility would be to allow Fred to issue further requests before receiving a response from Ginger. Unfortunately, this doesn 't
help, as Ginger will continue to try to stabilize the term and ignore any
further requests until she has stabiled the term.
Finally, the protocol could allow Fred to request multiple copies of a
dance that he uses individually to communicate with Ginger. This is definitely the most promising of our approaches as it is quite elegant and performs similarly to the "multiple requests" modification. Unfortunately, time
constraints prevented us from including this feature in the initial version of
the system. The capacity for multiple series of requests ( as each dance is
simply a series of requests) will be included in the version of the system
based on Term Tours.
5.1.2

Getting input from a user

In a typical session, a user requests output from the Reduction Engine which
then requests input from the Graphic Shell. The Shell then moves the
input window to the front and highlights the needed node. Until the user
chooses to define this node, the Shell is unable to respond to the Engine. A
problem similar to the one identified in Section 5.1.1 then results: the Engine
can't respond to the request from the Shell (since it lacks the appropriate
information) and hence the Shell can't send more requests to the Engine.
In practical terms, this means that the system prevents the user from
exploring the output until (s)he defines the requested node. The user can
still explore or extend other portions of the input term, but cannot learn
more about the output term without providing the requested information.
Again, the solutions of Section 5.1.1 are appropriate. We can therefore
solve this problems by providing for multiple simultaneous dances.

5.2

Graph Representations

Although it's certainly reasonable to represent terms as trees, there are many
times in which a term with many identical subterms might lead one to prefer

18

Figure 10: A cyclic graph that represents an infinite list of ones
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Figure 11: A portion of the tree representation of an infinite list of ones.
a more compact graph representation. For example, both Figure 10 and
Figure 11 might be used to represent an infinite list of ones ( the second only
shows a portion of that list). Clearly, the loop representation is superior:
although the tree looks like an infinite list of ones, it could also terminate
(perhaps at the next cons cell) and might contain elements other than ones;
the loop, on the other hand, makes it clear both that the term is infinite
and that it contains only ones. In addition, the loop is much more compact
than even the small portion of the tree shown in Figure 11.
We have considered the possibility of allowing the user to create cycles in
the input term, but the current protocol does not allow us to transmit any
information about graphs, let alone cycles. We feel that it is better not to
add graph information to the protocol as such information would effectively
allow programs to differentiate between eq and equal.
19

Another problem is that if we allowed users to create graphs , we would
certainly have to devise a new layout strategy. Although some good algorithms for graph layout exist ([2], [5]) , they do not fit our needs because:
• they aren't really designed for ordered graphs;
• they take a nontrivial amount of time to develop the layout ; and

.
• they operate on fixed , not changing, graphs.
Because we work in a system in which the structure of the graph may change
significantly in a relatively short period of time, a quick incremental algorithm is preferable for our application.

5.3

Conclusion

Streams are a basic data paradigm, and it is certainly wonderful to have
display mechanisms ( such as more) and lazy communication protocols ( such
as pipes) for streams. But there is more to life than just streams; many
forms of data can be represented more rationally as terms. Hence, both a
display mechanism for terms and a lazy term communication protocol are
needed.
Our experiments with building an interface for equational logic programs
have shown us that such mechanisms are quite useful. Even our preliminary
mechanisms, the Graphic Shell and the Dance protocol, indicate that term
communication and term display are productive and interesting areas of
focus .

5.4

Current Work

We have revised the Dance protocol and, in the process, renamed it Term
Tours. We are presently revamping the system to take advantage of the
added features of term tours (particularly a less strict response requirement
and the facility to duplicate connections).
A new version of the equational logic program compiler is now available
and we are building an appropriate run-time library for the new system that
will incorporate the Term Tour protocol.
As we mentioned in Section 5.2, we are also looking at ways to modify
both the protocol and the Shell to take advantage of graph information while
maintaining reasonable semantics.
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A

Using the Graphic Shell

This is a more in-depth reference guide for users the of Graphic Shell. It
covers many of the nitty-gritty details of the Shell.

A.1

Starting the Shell

In order to use the Graphic Shell, one must start A/UX, log in, and type
gshell. The Graphic Shell runs on the main console ( which, presumably,
is the only Macintosh monitor attached to the system). Unlike many Macintosh applications, the Shell does not start with a blank, "Untitled" document. Rather, it allows the user the choice of either creating a new term
(New under the File menu) or reopening an existing term (Open under the
File menu). Once a term is opened, editing and traversing can progress as
desired. Each term is displayed in a separate window.

A.2

Representations of Nodes

We use different typefaces and symbols to represent different kinds of nodes.
Both function symbols and integers are displayed with the standard Chicago
typeface. Atomic symbols are displayed in the Geneva typeface to differentiate them from zeroary function symbols. A node that has not yet been
defined is displayed as a question mark. Both closed nodes and nodes that
are compressed due to lack of screen space (i.e. nodes at the bottom of the
screen) are represented as boxed upside-down question marks.

A.3

Internal Representation of Terms

The Shell uses a document to store information about a term. This information includes: a symbol table, an in-core representation of the portion of
the term that has been defined, a selected node ( or a notation that no node
is selected), and a distinguished node in the term called top. As the name
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implies, the top node is the node that is displayed at the top of the display
window.
To maintain compatibility with the standard version of the equational
logic programming system, the Shell saves terms rather than documents
to files. It saves terms in an extended prefix notation and discards any
other information the document contains. This means that the top node,
the selected node, and information on the symbol table are lost when a
term is saved to a file. The Shell can rebuild most of the symbol table
from information contained in the term; however, it is unable to reconstruct
symbols in the table that are not used in the term, nor decide what the
previous top or select nodes were.

A.4

Menus

Like all Macintosh applications, the Graphic Shell provides a full set of
menus through which the user may send instructions to the shell. The Shell
organizes its commands into six menus:
• The Apple Menu
• The File Menu
• The Edit Menu
• The Display Menu
• The Commands Menu
• The Symbols Menu

A.4.1

The Apple Menu

Because we're running under A/UX, desk accessories are unavailable. Hence,
the only command provided under the Apple menu is About Graphic
Shell. This gives a short copyright notice and such. It may eventually be
expanded to give on-line help.

A.4.2

The File Menu

In general, the File menu deals with opening, closing, and saving documents.
Recall that although a document contains all the appropriate information
on a term, including both the term and the symbol table, only the term
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itself is directly stored. The following options are available under the File
menu :
New This creates a new local document. The only node in this document
is the unknown symbol ( the question mark). The symbol table for this
document is initially empty.

Open This prompts the user for the name of a file in which a term was
previously saved. If the file does not exist, a warning message is issued
and no document is opened.
Open Remote This opens a connection to a reduction engine and allows
the user to browse its output. Recall that the user must first specify
which document to use as input (using Publish Document under
the Commands menu).
Save This allows you to save the current document as a file. If the document
is untitled, then the user is prompted for a file name.
Save As ... Like Save, although it always prompts for a file name. This is
useful if you don't want to work with the original version of a document.
Close This closes the current document and removes the window from the
screen. If the document has been changed since the last Save, the
Shell asks the user if the new version of the term should be saved.
Quit This closes all open documents and exits to the operating system.
A.4.3

The Edit Menu

The Edit menu supports the usual Cut, Copy, and Paste commands for
use on terms. They a.re only available if a term is selected. Copy copies the
subterm rooted at the selected node. Cut copies the subterm and then removes it (replacing it with an unknown node). Paste replaces the currently
selected subterm with the subterm last Copied or Cut. Clear erases the
subterm rooted at the selected node and replaces it with an unknown node.
Unlike Cut, Clear does not save the subterm for later Pasteing.
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A.4.4

The Display Menu

The Display menu contains commands for manipulating the display of the
term. Thus, it contains commands to home nodes and to open and close
nodes. It also contains Redraw Screen to correct any plotting errors that
might occur.
Open Node and Close Node select whether the subtree rooted at
a given node will be displayed or not. Closed nodes are represented by
upside-down question marks. Users can also open closed nodes with a simple
double-click. In remote documents, closed nodes can also represent nodes
that the user has not yet examined. Opening such nodes triggers a series
of requests to the Reduction Engine.
Home Root, Home Node, and Home Parent change the choice
of topmost node. Home Root works at any time; the other two home
commands require a selected node.

A.4.5

The Commands Menu

The Commands menu is used to prepare Dance information. It allows the
user to select:
• the reduction engine that the system should use (Set Engine Command)
• the machine on which the engine should be run (Set Engine Host)
• the document reduction engine should use as input (Publish Document)

A.4.6

The Symbols Menu

The Symbols menu is used to define nodes in the document and symbols
in the symbol table. As mentioned previously, the Shell does not save the
symbol table with a. term but rather reconstructs the symbol table from
information contained in the saved term.
The bottom half of the Symbols menu contains the function symbols
that are used in the term. This is the complete list of such symbols and
may be extended through the use of the New Symbol command. When
the user selects New Symbol, the Shell puts up a dialogue box requesting
the definition of the symbol. One defines a symbol by giving the name of
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Menu Option
Open
Quit
Undo
Cut
Copy
Paste
Redraw Screen
Next Stabilization
Interrupt
New Symbol
Atom
Integer
Unknown

Key
0
Q
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X
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I
?

Menu
File
File
Edit
Edit
Edit
Edit
Display
Commands
Commands
Symbols
Symbols
Symbols
Symbols

Figure 12: Keyboard equivalents of menu commands.
the symbol, a colon, and the arity of the symbol. For example, the proper
definition of cons is
cons: 2
A user defines a node in the term either by selecting one of the functors in
t he bottom half of the menu or by selecting Integer, Atom, or Unknown.
Integer and Atom prompt for the value of the symbol.

A.5

Keyboard Shortcuts

To give users shortcuts, the Shell allows the user to perform most commands
through certain keystrokes prefaced by the command key. The keyboard
equivalents are shown in Figure 12.

A.6

Arrow Keys

The arrow keys only operate when a node is selected in the current document. Their effect is to change the selected node. The up-arrow key moves
up , selecting the parent of the currently selected node. The down-arrow key
moves down to the children of the currently selected node. The child whose
number is lar~ty J + 1 becomes the currently selected node. At first glance,
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this number may seem odd; however, it works quite well with lists ( allowing
one to traverse the sequence of cons eels). The left-arrow and right-arrow
keys move left and right, respectively, between the siblings of the currently
selected node. If a user strikes the right-arrow key when the rightmost node
is selected, then the leftmost nodes becomes selected (similarly for the leftarrow). These motions are robust; illegal operations (such as moving up
from the root or down from a leaf) are simply ignored .
At present, menu equivalents of the arrow keys are not supported. We
assume that a user who prefers to use the mouse will prefer the point and
click on a node method of selection. A Move menu may be included in future
vers10ns.

A.7

A Few Words on Robustness

We have tried to make the Shell as robust as possible. This is achieved
through warning messages, dimmed menu items , appropriate expansion of
commands, and special troubleshooting commands. Examples of each of
t hese methods of protection follow.
If a user attempts to redefine a previously defined node (either with
Paste or a selection under the Symbols menu), the shell always asks before
replacing the node. If the node had been sent to the Engine, then the Shell
does not allow the replacement.
Menu items are only available when they're appropriate. For example ,
if no node is selected, one cannot Cut, Copy, or Paste. These menu items
are dimmed when there is no currently selected node.
As mentioned previously, if a user attempts to scroll the screen by means
of the arrow keys, appropriate Home commands are generated so that the
selected node remains on the screen. This is what happens with standard
text editors when a user attempts to move the cursor off of the screenthe text scrolls in the appropriate direction. Here, we simply scroll terms
instead of text.
Finally, when something is wrong with the term display, a user need
simply select Redraw Screen and the term will be redrawn.
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